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M|Replay is the first instant replay software available for the Mac, and is an ideal solution for video 
production or as an adjudication system for referees.  Like all Softron products, it is Affordable, 
Reliable, and Easy-to-use.   

The M|Replay Manual is broken into two parts.  Part 1 provides a Quick Start Guide to let you jump 
right in and start using the application.  Part 2 provides a Features Overview, a brief description of all 
of the specific features available in M|Replay. 

New with M|Replay 2 
With M|Replay 2, we have added a number of new features: 

• We have made the Viewers swappable (page 8) 

• We have added (and changed) Keyboard Shortcuts (see page 10) 

• We have added support the the SKAARHOJ XC8 and Elgato Stream Deck controllers (see pages 
16 and 23 respectively) 

• REST API integration: You may now control M|Replay remotely through a URL address (see page 
24) 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Part 1: Quick Start Guide 

Installing the drivers for your video device 
If you use a video device from AJA, Blackmagic Design or our M|Family (M|8R, M|80, M|62, M|44) 
make sure that the device is physically connected. Double check that all cables and hardware are 
installed correctly.  

Also check that you have the appropriate version of the driver and OS: 

1. On the Softron website, check which driver and OS is recommended for the card you use. 
2. Download the appropriate driver from the AJA, Blackmagic-Design or Deltacast website. 
3. Make sure you use a compatible version of macOS 

Once the drivers are installed, verify the settings of your card using the Preference pane or control 
application (if applicable) included with the hardware. For example, with the M|8R, (or when using a 
Blackmagic-Design Quad 2 card), you may want to modify the “Connector Mapping” to make sure 
you can use all 8 connectors independently. 

In terms of licenses, you will need one license per channel. And each channel can be either in or out, 
so there is a lot of flexibility depending on the type of use that you want to have. 

Software Installation 
1. Download the M|Replay software from our website . 
2. Unzip the downloaded file. 
3. Drag and drop the M|Replay.app file in your Applications folder. 

First start 
1. Start the application: Double click on the M|Replay icon in your Applications folder 

2. When prompted with the message “The “M|Replay.app” is an application downloaded from the 
Internet. Are you sure you want to open it?”, Click on Open. 

3. A license agreement window will open. Enter your First and last name and a valid email address. 
Tick the check-box and click on “Accept” 

4. Enter an admin password, to install the required components 

5. If you have a dongle connected to the computer with valid licenses for M|Replay, the application 
will start right away. 

6. If you do not have a dongle connected, a license window will open to offer you 3 choices: 

• Register: if you own a serial number, click on this button and follow the procedure to 
activate it. You can read more about the activation procedures on our support desk. 

• Buy: if you don’t have a serial number, but want to buy one, click on that button. 
• Demo: if you want to try the application in DEMO mode, click here. In DEMO mode, M|

Replay can only create new Live sessions, it can not reopen an archived session. When 
a new Live session is created, there will be blue frames recorded in the files as well as 
blue frames outputted to the outputs. 

• Note that the license window will only open the first time you start the application. If you 
want to add a license, and upgrade or option later on, you can access the license 
window in the Menu “M|Replay > Licenses…”  

7. That’s it — you are ready to use M|Replay! 
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The Welcome Window 
When you start M|Replay, a “Welcome window” is displayed.  

From this window you can either  

• “Create a new Live Session…” if you want to start recording and replaying a new session, or  

• “Open Archived Session…” to reopen a session that has already been recorded. 

You can also see the list of sessions recently created or opened on the right, with their creation date, 
and size. If you right-click on any of these you can select to “Show in Finder” to be able to see where 
those sessions are saved and eventually delete them if you don’t need them anymore. 

Creating a New Live Session 
When you click on “Create a new Live Session…”, this window will open: 

• Select a “Name” for your Live Session 

• Set where you want to “Record to” (make sure to have enough disk space available) 

• Set if you want to “Pre-allocate SAN storage if possible”. Some SAN Volumes allow for pre-
allocation (such as Xsan). If possible we will try to preallocate the storage, so only one write 
request is done to the SAN. Note that this won't actually write or use the storage, it is "just" 
doing just one request at start, instead of a request overtime we need to write to the disk. 

• Select the “Video Mode”. This will set the format of all the inputs and outputs. 

• Preset duration: When you enable an input, we will start recording right away and create a 
“Classic” movie file (as in MovieRecorder) of the duration you specify here. Note that if your 
recording session is longer than that, we will extend the duration up to 9 hours which is the 
maximum duration of a recording session (because of a limit to the duration of QuickTime 
movies). When your session reaches 9 hours, recording will stop. 

• Remaining Space: Already shows you how much disk space you have left on the selected 
destination. 
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Enabling Inputs and outputs 
In the left pane you will see all the inputs and outputs that are available on your Mac.  

Depending on which video device you use, you will be able to see more or less of them. Note that for 
some devices (such as with the Decklink Quad 2), if you enable for example the input 1, you won’t be 
able to enable the corresponding output 1 as these inputs or outputs share the same connector. 

If you use the M|8R or a Decklink Quad 2 or Duo 2, make sure to read the article of our knowledge 
base that explains the things to know about the “Connector Mapping” 

Important note: As soon as you enable an input (by ticking the checkbox in front of it), the 
recording starts, there is no start record button. If you want to stop recording on that specific input, 
just disable it. To enable an input, you can also simply drag and drop it on any of the Viewers in the 
central Viewers area. 

You can also enable the outputs that you need for the production simply by enabling the checkbox or 
drag-and-dropping the output on any of the Viewers. 

Note that you can also create “Virtual Outputs” simply by clicking on the + icon at the bottom of the 
list. Delete them using the - icon. Note that “Virtual Outputs” are used rather for testing purposes, or 
for example to preview a playlist on screen, without using a “Real video output”. 

The Viewers Area 
The Viewers area is the main area. The Viewers can either be used to monitor inputs or outputs. You 
can assign an input or output to a Viewer either: 

• Drag and drop the inputs or outputs from the left pane to the Viewer(s) you want to assign them 
to. 

• Click on the popup menu on the top left of the Viewers and select the input or output you want 
to monitor in that specific Viewer. 
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Assigning an input to an output 
When an output is selected, you will also see a popup menu at the top right that allows you to select 
the input that is “sent” to that output.  

You can also change that using keyboard shortcuts: 

• First make sure that the “Viewer” with the output you want to control is selected (circled in 
blue). For that you need to either: 

• click on it 

• use the keyboard shortcuts 1, 2, 3… to select the first Viewer, the second, etc… 

• Then once the viewer is selected, either: 

• alt+click on the viewer of an input to “assign it” to the selected output 

• use the keyboard shortcuts alt + 1, 2, 3… to assign the input in the first Viewer, the second, 
etc… to the selected output. 

Playback controls in the Viewers area 
You can control the playback in the Viewers area in one of these manners: 

• At the bottom of the user interface are some playback controls to play forward, backward, or at 
variable speed.  

• Use the keyboard shortcuts. For example the standard JKL, space bar, left, right arrows and “P” 
to go back in “Live”. (See a more complete list below) 

• Use a Contour Shuttle USB device. (See diagram below) 

Note that when you use those playback controls, all the inputs will be controlled in sync, so you can 
see what happens on all angles at a specific moment. 

Swapping Viewers 
As of M|Replay 2.0, you may swap the locations of viewers. You may simply click on a viewer and drag 
it over another viewer, release the mouse, and the two viewers will change position. 

Clips and Markers 
Creating clips and markers 
To create clips and markers, make sure that the “Viewers” area is active, then go to the position you 
want and use the following keyboard shortcuts: 

• I to create an in point 

• O to create an out point 

• M to create a marker 

Note that when you have set an in point the ‘In’ icon will be shown.  

• If you use try to set an in point again, the in point value will be modified 

• Then if you set an out point, the clips will be immediately created and shown in the Browser area. 

You can also use the following keyboard shortcuts: 

• alt + I (or O) to clear the in or out point 

• alt + x to clear both in or out points 

• shift + I (or O) to go to the in or out point 
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Modifying clips and markers 
To modify a clip and marker, you can : 

• click on its name to modify its name 

• click on its in or out points to modify manually their value 

Using clips and markers 
From the Clips and markers are, you can: 

• double-click on a clip to start playing it back from its in point. If you hit play it will play until its out 
point 

• double-click on a marker to start playing from that point 

Creating Playlists 
You can drag and drop clips to the playlist area. You can use clips from the clips and markers area 
above, or other clips from your storage. 

When a clip is in the playlist area, you can select the “angle” that you want to play out as well as the 
playback speed. 

To play the playlist, you need to make sure that an output is selected for that playlist. 

Exporting Clips and playlists 
You can export clips and playlists so they can be reused later on. 

Changing the export settings 
As we want things to go quick during a live session and don’t want to have menu asking for settings, 
the export settings are done in the preferences of the application. 
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You can set: 

• In point handle: set the number of seconds you want to add before your in point to the exported 
clip 

• In point handle: set the number of seconds you want to add after your out point to the exported clip 

• Export Directory: set where the clips will be exported 

Exporting Clips 
From the “Browser” area, select the clips you want to export. Then right click on it and select “Export” 
from the drop down menu. The export will start right away. Note that all angles of the clip will be 
exported.  

You can cancel the export of one or more clips by selecting the clips for which you want to cancel the 
export, right click on it and choose “Cancel Export”. 

Exporting Playlists 
Note that currently only clips from the recorded angles will be exported. External clips will be skipped 
during export. The method to export playlists is the same as the one for clips. Note that the if you 
modify the playlist after you have started an export, it won’t reflect in the exported file, you will have 
to export again the playlist. 

Keyboard shortcuts 
A number of keyboard shortcuts are available to control the UI, in addition to Mouse and other 
controls (see below for available Controllers). Note that some of the keyboard shortcuts have 
changed from M|Replay version 1 (“Old”) and 2 (“New”). 

Viewers area - Playback Controls

OLD NEW FUNCTION

J J Cycle through the different playback speed going 
backwards

K K Pause

L L Cycle through the different playback speed going 
forward

Space bar Space bar Play/Pause

G G Go to “Live”

ctrl + G ctrl + G Go to “Specific Timecode” (enter TC)

+ + Go to “+ x time” (enter TC)

- - Go to “- x time” (enter TC)

Home Home Go to beginning of Session

End End Go to end of session

OLD NEW
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→ → + 1 frame

← ← - 1 frame

FUNCTIONOLD NEW

Viewers area - Selecting Viewers and assigning inputs

OLD NEW FUNCTION

1, 2, 3 SHIFT + 1, 2, 3,.. Select the viewer you want to control

alt + 1, 2, 3 1, 2, 3,… Assign the input located in the corresponding 
viewer to the selected output

Clips and markers

OLD NEW FUNCTION

I I Set an in point

O O Set an out point

Shift + I Shift + I Go to in point

Shift + O Shift + O Go to out point

Alt + I Alt + I Clear the in point

Alt + O Alt + O Clear the out point

Alt + X Alt + X Clear both in and out points

E E  Append selected clip(s) to the end of the current 
playlist

W W Insert selected clip(s) before the selected clip of the 
current playlist

cmd + E cmd + E Export the selected Clips to the location defined in the 
preferences

cmd + shift + E cmd + shift + E Export the selected Clips to a location that you will 
define
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Playlists

OLD NEW FUNCTION

Space bar Space bar Play/Pause

alt + Space bar alt + Space bar Force cue of selected clip

alt + → alt + → Skip to next

alt + ← alt + ← Skip to previous

alt + cmd + → alt + cmd + → Go to 5 seconds before the end of the current clip

alt + cmd + ← alt + cmd + ← Go to 5 seconds before the end of the previous clip

Shift + O Shift + O Go to out point of selected clip

alt + L alt + L Toggle the playlist Loop mode

alt + C alt + C Toggle the playlist Loop mode

cmd + E cmd + E Export the selected Playlist to the location defined in 
the preferences

cmd + shift + E cmd + shift + E Export the selected Playlist to a location that you will 
define

UI navigation

OLD NEW FUNCTION

⇥ ⇥ Cycle in the different areas going forward 

⇧ + ⇥ ⇧ + ⇥ Cycle in the different areas going backwards 

cmd + ⇧ + S S Go to the Sources Pane

cmd + ⇧ + M V Go to the Viewers area

cmd + ⇧ + L B Go to the Browser area

cmd + ⇧ + P P Go to the Playlists area
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Controllers 
Currently M|Replay supports the Contour ShuttlePRO v2, SKAARHOJ XC8, and Elgato Stream Deck 
controllers. We will add more controllers over time — don’t hesitate to let us know which one you 
would like to be supported. 

Contour ShuttlePRO v2 
Viewers area 
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Clips and Markers Area 

 

www.softron.tv - For our Facebook, Twitter, Skype or YouTube pages, search for: SoftronMedia  -   14

http://www.softron.tv


M|Replay - User’s Manual
Playlists Area 

 

www.softron.tv - For our Facebook, Twitter, Skype or YouTube pages, search for: SoftronMedia  -   15

http://www.softron.tv


M|Replay - User’s Manual

SKAARHOJ XC8  
Starting with M|Replay 2.0, we have added the support for the SKAARHOJ XC8 hardware controller. 
This allows for higher efficiency when using it as a replay system as a lot of functions are readily 
available at your fingertip. 

  

 

Requirements for the setup 
To setup your XC8: 

• First you will need to connect your XC8 in USB to your Mac (you'll only have to do this once). 

• Then download the firmware updater application from SKAARHOJ: https://www.skaarhoj.com/
support/firmware-updater/ 

• Install the application and start it.  
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• Make sure that you do see something like this in the "Port" popup menu:

  

• If the menu is empty, check your USB connection to the XC8.  

If you see something like usbmodem143220 in the popup menu, you are ready to set it up. 

Note that: 

• the USB connection is only needed for the setup part, not to control the XC8 after it has been 
setup. Control later on is done through ethernet. 

• the USB connection is mandatory for the setup part, you can not do the setup through ethernet 

  

  

Setting up the XC8 as a "Raw Panel"  
Note that your XC8 may come already configured as a "Raw Panel", and in this case you can skip this 
step, you won't need an internet connection, and you just can setup the IP address if needed (see 
below). But if your XC8 is not configured as a Raw Panel (for example it was used with another 
software or hardware), you will need an internet connection the first time you want to setup your XC8 
following these steps. 

• (first follow the steps above for the App. Once setup, click on the "Online Configuration" 
Button: 

• This should open a web page on SKAARHOJ's website where you can make sure that it's the 
"XC8-Raw Panel" configuration that is Active, if not, click on the radio button, so it shows as 
Active. 
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•   

  

• Note that the screenshots here are with the "simple" configuration. Note that there is an 
"Advanced" button on the page that can show you more settings. You can work with the 
Advanced view too, just make sure to configure the panel as a "Raw-Panel"... 
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• Then at the bottom of the window set the Network configuration. The first part is the IP 

configuration of your XC8:

  

  

  

• And the last part, in the "Devices" area, setup the IP address of the computer that will control 
the XC8 (note that these IP configurations can be modified directly from SKARHOOJ's 
application on your Mac, you won't always need an internet connection just to change the IP 
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address):

  

  

• Now save on the "SaveNetwork Configuration" button at the bottom of the page:

  

• Now that you have saved that configuration, you can go back to SKAARHOK App, and click on 
the "Check for updates" button, and you should see that a new firmware is created (based on 
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the settings that you have just done):

  

• Then you should see different phases, (updating, verifying, etc...) and when it says that the 
Firmware was updated, your XC8 has rebooted, and you should be good to go. 

• Now you can start M|Replay, create a new session and the button will light up (note that the 
buttons will only light up once a session is created or opened). 

  

Modifying the IP configuration with the App (no internet access) 
Again the steps above are only if you have to configure the XC8 as a "Raw Panel", if you just need to 
change either its IP address, or the IP address of the computer that controls it, you can do that simply 
with the SKAARHOJ App: 

• First click on the "IP Configuration" button: 

•  
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• In the window that opens, you will be able to set first the IP settings of the XC8 itself. Enter an 

IP address that is within your IP range, or enable the DHCP setting.

  

• Then in the second part of the window, even more important, set the IP address of the 
computer that will control the XC8, and make sure that the "Enabled" checkbox is indeed 
enabled: 

•    

• Then click on "Save IP Settings" 

  

Understanding the configuration and IP recommendations 
As you can understand from the last part of the setup, it is the XC8 controller that will in fact connect 
to your computer, and not the other way around. You don't need to set any IP address of the XC8 on 
your computer itself or the M|Replay preferences. It's the XC8 who know who it will talk to. 

The downside of this is that it means you will need to connect to your XC8 with USB every time you 
want to use a different computer with M|Replay or every time your IP address changes. This is why if 
you can enable DHCP for the XC8 itself, it is recommended to use a fixed IP address for your 
computer and not DHCP. Otherwise, you may loose connection to your XC8 when restarting your 
computer (as your DHCP server may attribute you with a different IP address). 

  

Cores vs Raw Panel 
If you are familiar with SKAARHOJ, you may know that they are using the concept of "Cores", which 
are basically the ability to control other devices. SKAARHOJ's controllers can be used in many ways, 
and one device can sometimes control multiple pieces of equipment. All this needs to be configured. 
The idea that they had is that you configure your device on their website, add "Cores" (such as a Core 
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to control an ATEM, one to control a Camera), then setup what each button will do on your 
SKAARHOJ's device. Then once you have configured it, you save a firmware that is then loaded on 
your device. 

This is very nice in terms of flexibility, but at Softron we try to do things that are "plug and play". So 
this is why we have not implemented Cores, and have done all the work for you. ;-) Once the panel is 
configured as a Raw panel, we will just control it, there is nothing that you need to setup. But don't 
search for Softron's core then... 

  

TROUBLESHOOTING 
If after you have followed the steps above, you still can not control it, check the following: 

• double-check that it is configured as a "Raw Panel" 

• make sure of your network connections. Check the IP of your computer, then check what you 
have set in the "Unisketch Raw Panel" preference in SKAARHOJ App > IP Configuration. The 2 
must match. If they match, make sure that you can "ping" the XC8 from your computer, there 
might be a network issue. Don't forget that M|Replay connects to the XC8 with Ethernet, not 
with USB. 
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Elgato Stream Deck 
As of version 2.0, M|Replay is compatible with Elgato’s Stream Deck Controller. Simply plug the 
Stream Deck’s USB into your Mac, and M|Replay will recognize the device. From the Controller you 
will be able to quickly and easily create pre-labeled Markers. A number of sample Markers are 
preprogrammed with M|Replay (see below), but the Stream Deck is customizable so you can add your 
own pre-labeled markers. 
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Using REST API to Control M|Replay 
With M|Replay, you can create markers in the user interface but also using a REST API. This means 
that you can create markers remotely from simple web page.  

Currently the only thing you can do with the REST API is to add new markers. If you have any 
additional request, please let us know. 

M|Replay uses port 8082 by default, but this can be configured in the preferences of M|Replay.  
 

Creating markers 
To add a marker, you need to use the POST method and pass a json dictionary with "name" to set the 
title of the marker. The marker will be added at the same position that the "playhead is". So if the user 
is playing back something in the past, it will use the current TC, not the "Live" TC. 

POST markers
     {
         "name" : "This is my Marker"
     }

 
About the authentication 
If the user has enabled the option to require a password, then you need to specify it with your 
requests. The default password is "1234". 

 POST markers?password={password}
     {
         "name" : "This is my Marker"
     }

 
 
Retrieving markers 
You can also retrieve the list of markers that were already created: 

GET markers

This will return a dictionary with the list of sources available for a MovieRecorder, which should look 
like this: 

[
     {
         "name": "My First Marker",
         "start": 511090399.1733954
     },
     {
         "name": "My Second Marker",
         "start": 511090848.9727454
     },
         "name": "My Third Marker",
         "start": 511090850.8913287
     },
 ]
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Part 2: Features Overview 

The User Interface 
Almost everything that needs to be done in M|Replay can be accomplished from the User 
Interface.  As such, we will first describe the features available in the UI, and then we will go 
over the features available in the Menu. 

There are five main panels on the UI: the Inputs, the Outputs, the Viewers, the Browser, and 
the Playlist.  Each is described below: 

The Inputs 

M|Replay automatically detects all Input devices that are 
available to your Mac, and lists them in this section.  Each Input 
can be enabled (or disabled) by checking (or unchecking) the 
box to the left of the Input’s name.  You may change the name of 
the Input devices by right-clicking on the current name, and then 
typing in the new name. 

The Outputs 

M|Replay also automatically detects output devices that are connected to your Mac, and lists 
them in the Outputs panel.  As each license of M|Replay can be used for Input or Output, 
you may also click on a device and use the “+” button at the bottom of the panel to add more 
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Output channels (or click on the “-“ button to remove Output channels).  You may also 
change the name of the Output devices by right-clicking on the current name, and then 
typing in the new name. 

The Viewers 

The Viewers panel displays a number of important elements of M|Replay: the Current Time, 
the Delay, the In and Out Point Controls, the Playback Rate, the Viewers, and the Playback 
Controls, as well as a few other UI Controls.  

Each of these elements is described below.  This screenshot shows the Current Time, the 
Delay, and the In and Out Point Controls: 

Current Time: This is the actual current time. 

Delay: This shows the number of hours, minutes, seconds, and frames behind the Current 
Time, and is displayed when the clip has been rewound.  Note that while the clip is Delayed, 
it is still recording Live.  If the clip is playing Live in the Viewers, this display will show ”Live,” 
rather than as a Timecode display. 
 

The In and Out Point Controls: Flanking the Delay display are two round buttons, the one 
on the left labeled “In” and the one on the right labeled “Out.”  Clicking the In button will 
begin recording multiple clips — one per Input — and clicking on Out will stop the recording.  
While the clips are being recorded, the In button will be a solid white color, rather than an 
empty circle.  Once the recording is stopped, the clip will appear in the Browser panel to the 
right of the Viewers.  You may also use keyboard shortcuts to start and stop recording a clip: 
“I” to set the In Point, and “O” to set the Out Point. 

The Playback Rate:  This is the rate in which the Viewers are displaying the playback of the 
video inputs.  The Playback Rate is set using the Playback Controls at the bottom of the 
Viewers panel. 

The Viewers: Each Viewer may be set up to view an 
Input or an Output.  When M|Replay is first opened, 
each Viewer will be dark, with the Softron logo and 
a prompt in the upper left-hand corner asking you to 
“Select a Source…”   

You may click on the prompt and select the Input or 
Output source from the selection offered, or you 
may simply drag and drop an Input or Output source 
from the appropriate panel to the left.  If you select 

www.softron.tv - For our Facebook, Twitter, Skype or YouTube pages, search for: SoftronMedia  -   27

http://www.softron.tv


M|Replay - User’s Manual
an Output, a second prompt asking you to “Select a Source…” will appear in the upper right-
hand corner of the Viewer.  You may either drag and drop an item from the Input or Output 
panels, or you may click on the prompt and select a source from the list provided — which 
will include the Playlist in addition to the Inputs. 

Once your sources have been selected, the Viewers will display the Input or Output at 
whatever Playback Rate you select, and the Source name will be displayed at the top of the 
Viewer.  Also present on each viewer is a speaker icon, where you may turn the volume on 
or off.   

Below the Viewers are the Play-back Controls.   

The left-most group of numbers allow you to jump forward or backward 5 minutes (+/- 5’), 1 
minute (+/- 1’), 30 seconds (+/- 30”), or 10 seconds (+\- 10”), or to return to Live playback.   

The right-most group of numbers allows you to set the Playback Rate for the Viewers.  
Those numbers flank buttons to Play Backward, Pause, or Play Forward.  The numbers to 
those buttons are the Reverse Playback Rates, while the numbers to the right are the 
Forward Playback Rates.  The 32x, 16x, 8x, 4x, and 2x Playback Rates are Fast Rates (Fast 
Forward or Fast Reverse), while the Playback Rates marked with percentiles are Slow-
Motion Rates (Slow-Motion Reverse or Slow-Motion Forward).   

Below the Play-back Controls are some general UI controls.  From left to right, they allow 
you to Show/ Hide the Input/ Output Panels; Select the number of Viewers present on the 
User Interface; Show/ Hide VU Meters on the Viewers; Show/ Hide Timecodes on the 
Viewers; view the Remaining Space on your storage device; and Control Volume, Show/ 
Hide the Browser/ Playlist Panels. 

The Browser 

The Browser panel shows the Clips you have created by using the Input and Output 
Controls.  It also shows any Markers you have created (by hitting “M” on your keyboard, or 
by clicking on the “+” button at the bottom left of the panel).   

The Browser includes four headings: Name (the name of the Clip or Marker, which can be 
modified by highlighting and then clicking on the name, and then typing in the new name); 
Start (the start time of the clip); End (the end time of the clip); and Duration (the Duration of 
the Clip, in Hours: Minutes: Seconds: Frames).  Note that Markers do not show an End time 
or Duration — the Marker presents only the time that it was created.  Clips are identified 
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with a film strip icon to the left of the name, while 
Markers are identified with blue pointer icons. 

Right-clicking on a Clip opens a pop-up menu that 
allow you to Export (to the destination presented 
in the Preferences tab of the Menu), Export To… (a 
destination chosen when you select this item), 
Cancel Export, Show in Finder (shows the location 
of the exported files in Finder), Go to In (takes the 
Viewers to the In Point of the Clip), Go to Out 
(takes the Viewers to the Out Point of the Clip), or 
Delete (deletes the Clip). 

Right-clicking on a Marker opens a pop-up menu 
that allows you to Go to In (takes the viewers to 
the In Point of the Marker) or Delete (deletes the 
Marker). 

Double-clicking on a Clip takes the Viewers to the 
In Point of the Clip, and the Viewers will play until it 

reaches the Out Point, at which time the Viewers will Pause. 

Double-clicking on a Marker takes the Viewers to the In Point of the Markers, and the 
Viewers will play from that point. 

You may delete any Clip or Marker by selecting it and then clicking on the “-“ button at the 
bottom left of the panel (or by right-clicking on it and selecting Delete on the pop-up menu). 

Playlist 

You may create a Playlist here to play out highlights of the event you are recording.  To do 
so, simply drag and drop any desired clips from the Browser to the Playlist panel.   
 

At the top of the Playlist Panel are two Timecodes.  The one on the left shows the time 
played on the currently playing Clip (and is also showed as a bar to the right — the lower of 
the two bars).  The Timecode on the right shows the time remaining for the entire Playlist 
(displayed as a bar to the left — the uppermost bar). 

Below the left Timecode is the Select Output button.  Clicking on it allows you to select the 
Output on which you would like to play out the Playlist.  To the right of that are standard 
Playback Controls (Play Previous Clip, Pause, Play, and Play Next Clip), and then buttons to 
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Chain the Clips (play each clip in sequence) and to Loop the Clips (replay the selected Clip 
over and over, or to replay the entire Playlist if both the Chain and Loop buttons are active).  
When the Chain or Loop buttons are active, they will be displayed in blue. 

Below the Playback Controls are the Clips you have dragged from the Browser.  Each Clip 
has a thumbnail to the left, the Playback Rate below the name (adjustable by highlighting the 
clip and then clicking on it, which opens a window with a sliding bar and numeric indicator, 
both of which can used to adjust the Playback Rate).  To the right the Clip Duration is 
displayed, below which is shown the selected camera-angle (which may be changed by 
clicking on and then selecting the Input you would like to use). 

Right-clicking on a Clip opens a window that allows you to Export Playlist (to the default 
destination, as determined in the Preferences menu), Export Playlist To… (a destination 
chosen when you select this item), or to Cancel Export. 

At the bottom-left of the Playlist Panel are two buttons: a “-“ and a gear.  The “-“ button 
allows you to delete a clip (by selecting the clip and then clicking the “-“ button).  Clicking the 
gear button opens the same Export window accessed by right clicking on a Clip. 
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The Menu Items 

There are six tabs available in the M|Replay Menu Bar: M|Replay, File, Edit, View, Window, 
and Help. 

M|Replay 

There are 8 items in the M|Replay tab: About M|Replay, Preferences, Licenses, Services, 
Hide M|Replay, Show All, and Quit M|Replay.   
 

About M|Replay: This opens a window that displays the Version Number, License Info, and 
Copyright information. 
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Preferences: This open the Preferences window, which includes three tabs: General, 
Timecode, and Export.   

In the General tab you may enable M|Replay to Deinterlace the output by checking the 
appropriate box.  Here, as well, you may set the amount of information present in the logs by 
clicking setting the Technical Log Level. 
 

In the Timecode tab you may set the Timecode Source.  Note that you must hit the Apply 
button to apply any changes made to the Timecode Source. 

In the Export tab you may set up the default settings for exporting clips or playlists. 

The Export Directory presents the destination for any exported clips or playlists, and can be 
changed by clicking on the Select button and choosing the destination’s path. 

The If File Already Exists box allows you to automatically decide what to do with a clip or 
playlist if you already have one of the same name in the destination.   
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You may also add Handles to the clips.  Entering a number in the Seconds at the beginning 
box will add extra seconds at the beginning at end of clip, while entering a number in the 
Seconds at the end box will add extra seconds at the end of a clip.  This gives the user has 
some extra margin in case he needs to do fade in/out, etc… 

Licenses…:  

This pulls up the registration and activation panel.   

It will display the serial numbers and description (including the version number) of the 
installed M|Replay software, and if the serial number is activated a ✔ will be displayed to the 
left of the number.   

Directly below the serial number box are two buttons: Add Serial Number… and Clear All 
Serial Numbers.  Clicking the Add Serial Number… button opens a box wherein you may 
type in (or cut and paste) a purchased serial number.   

The Clear All Serial Numbers button allows you to clear all expired serial numbers from your 
system — recommended before you add new serial numbers, to prevent potential conflicts 
when your computer is searching for active numbers. 

Once a serial number is entered, it must then be activated.  If the computer is connected to 
the internet you may click on the “Activate via internet” button.  

To deactivate a serial number you would click on the “Deactivate via internet button” to the 
right.  You must deactivate your license BEFORE doing any of the following: 

• you move your disk from one computer to another 
• you have made a clone of your hard drive and you want to start from the cloned hard drive 
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• you reformat your drive and reinstall it 
• you upgrade your system OS (for example from 10.6.x to 10.7.x) 
• you delete or modify the file (example for M|Replay) : /Library/Application Support/Softron/

MReplay System ID 

If your computer is not connected to the internet, you may activate or deactivate your serial 
number manually by clicking on the appropriate button near the bottom of he panel. 

There is also a button at the bottom left of the panel that will take you to the Softron website, 
where you may purchase a new serial number.   

At the bottom right of the panel is the Close button, which will close the Licenses… panel. 

Services is an OS feature, so we will not go into it. 

Hide M|Replay sends the application into the background. 

Hide Others sends all other software operations except M|Replay to the background. 

Quit M|Replay shuts down the application. 

File 

The File tab includes four items, each of which are self-explanatory: Start New Live Session 
(just as in the Welcome to M|Replay window), Stop and Archive Current Session (stops the 
recording and archives the session), Open Archived Session (opens Finder and allows you 
to select an archived session, just as in the Welcome to M|Replay window), and Close (which 
closes the M|Replay application). 

Edit 

The Edit tab is standard for the OS X, and will not be detailed here. 

View 
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The View tab provides some modifications you may make to the User Interface.   
 

Here you may set the number of Viewers displayed on the UI, the number of VU Meters 
displayed on each Viewer, or command the the User Interface to Enter Full Screen. 

Window 

The Window tab allows you to Show or Hide the various panels and windows available in M|
Replay, including the Welcome to M|Replay window, the Activity & Logs Window, the Inputs 
(and Outputs) Panel, the Viewers, the Browser, and the Playlist.  Here you are also able to 
Minimize or Zoom the UI window. 
 

Help 

The Help menu provides the means to seek assistance with M|Replay.   

The Search box allows you to search MacHelp, and also allows you to search for and open a 
menu item (for example, typing “Schedule” would open the window on the right. 

Contact Softron Support… opens a window that allows you to gather logs and open a 
support ticket if you are encountering a situation that you were unable to solve by means of 
our Knowledge Base web site.   
 
M|Replay Help is not currently available. 
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